1RENESAS Release Note
QE for AFE V2.1.1

Release Note

Thank you very much for using the QE for AFE V2.1.1.

This release note covers product installation, restrictions, and so on. Please read this document before using
the product.
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QE for AFE V2.1.1 Release Note

1. About QE for AFE

1.1 Summary

QE for AFE is an evaluation tool for embedded system development that performs graphical tuning with an
built-in analog front end (AFE). Using this tool, you can set the AFE registers, write the registers into the
evaluation board, and monitor the AFE tuning results in a waveform.

To use this tool, you must have a board that supports QE for AFE. QE for AFE is connected between PC and
the board through USB cable and communicates with the board.

1.2 Functions
The main functions are listed below:

1. Connect and operate the evaluation board
Config AFE related registers with GUI
Display graphics of the AFE tuning results and digital filter frequency response

Display graphics of the user application measurement values

S A

Generate code with RX SmartConfigurator or RA FSP when working as e? studio plug-in,

1.3 New Functions

1.3.1 Support RX23E-B
QE for AFE V2.1.1 starts to support RX family. RX23E-B is the first supported device.

E Device Selection O X

Please select the device for AFE adjustments.

Series RX b
Device RX23E-B b

Figure 1-1. Device selection
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1.3.2 Support [Application] function

QE for AFE V2.1.1 starts to support [Application] function, which can display graphics of the measurement
values of user program. In addition, it is possible to send values to user program and the user program can
be controlled by the ON/OFF button. Please refer to related user program application note for details.

&M

User value settings. ~

Channel setting
BFAcHo FICHT ZiCcH2 ICH3 [ICH4 [ZCHS [CHB [ZCHT [Z1CH8 []CHS [ICHI0 [1CHI [ CHI2 ZICHI3 (7] CHIA [ CHTS Ovawet [0 |
Ovawez[o ]
I —
S
Ovawes[c |
Dvsf
Ovawer[o ]
S —

[ Aute Scaling CHO ~ No.- Time:-ms Value-

Generic button

Button1

Button2
000 S000D00 100000 15000000 20000000 25000000 30000000 35000000 40000000 45000000 500000.00 Button3
= Buttond

< 2 Button5

» Parameters Buttoné

» Legend

Button? = ~

AFE Connection  Monitor  Application

Figure 1-2. Application function

1.3.3 Improve the workflow view

QE for AFE V2.1.1 changes the main view to the workflow view, which contains more detailed guide
information and is easier to understand and operate.

IE| Z Overview < Prepare a Project Prepare AFE Adjustment Adjust AFE

1.0verview -

<P

Select a Project

/\/“ Obtain More Informarion
Prepare a project that reflects the results of the AFE adjustments

2.Prepare a Project - Select the target project
/\/\, Select a Project I
razal ~
(%) Configure FSP Serics. RAZAI
Device: R7TFA2AIAB3ICFM
3.Prepare AFE Adjustment ¥ | Boards: EK-RA2A1

Prepare the Adjustment Program .
Select an e* studio project to be used for configuring AFE

,"\ Select Operation Voltage Please refer to the following table to create a QE AFE supported project using the e? studio
Connect to Board
Series Device Board

4.Adjust AFE h RAZA1 |R7FA2AIAB3CFM |EK-RA2A1
Configure AFE RX23E-B | All Device Depending on the function used. please refer to the QE for AFE for details
Check Results

When creating an RX23E-B project. select the Smart Configurator as the coding assistant tool. After creating
Adjustment Results 1. use the Smart Configurator to set 1 PCLKB and PCLKC clock. Afte:

the project 1s d using the
project m the final step

gs, select the project as the target project for QE AFE. Additionally, wh
Smart Configurator, then can the AFE configuration be reflected to the targ

Notes of [Modify an existing project] :
If the selected project 1s not supported by QE AFE, please modify the selected project according to the
prompts. After modification, perform the corresponding operation to reflect the changes to QE AFE tool.

» After modifying an RA project: Save the selected project in e? studio.

» After modifving an R¥ project: Click "Generate Code" at Smart Configurator.

QE Series How to install'uninstall How to update FAQ Licen

Figure 1-3. New workflow view

The workflow view can switch between two styles according to the window's width.

»  Guide style
Press the menus on the left to show the setting items on the right part. Step by step from the top of the
menu.

»  Simple style
Show all settings. Step by step from the top of the workflow.
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Note: The setting items of both workflow styles are the same as the old main view.

[A]| © Overview ©OPrepareaPre. PrepareAFE = AdjustAFE
1.0verview ~
f)
Al @ Overview (©)  Prepare a Project Prepare AFE Adjustment Adjust AFE @) Obtain More Information
1.Overview - C Select a Project Open the Web Site
() Obtain More Information g
Prepare a project that reflects the results of the AFE adjustments 2.Prepare a Project ~
2.Prepare a Project - )
Select the target project (©) Select a Project
(%) Select a Project P | -
e ‘ x23eb ~
3.Prepare AFE Adjustment | Series: RX23EB Series. RX23EB
Device: RSFS23E6NxFP i Device: RSFS2XE6W
Prepare the Adjustment Program Boards: Custom User Board Guide style e R Siniple style
Connect to Board B -
Selectan ¢? studio project to be used for configuring AFE. 3.Prepare AFE Adjustment ~
4.Adjust AFE b Please refer to the following table to create a QE AFE supported project using the e Prepare the Adjustment Program
Configure AFE sudie
Check Rewale P Device — Download and Import Adjustment Program
Select dowaload tool
Adjustment Results RA2A1 [R7FA2AIAB3CFM |EK-RA2AL "
&2 studio v
RX2E- |,p Depending on the function used, please refer to the QE
= evice T Specify fp-cli.cxe path

Select COM port

Write the Adjustment Program on the board

Figure 1-4. Styles of new workflow

1.3.4 Eliminate the limitation of monitoring time width
QE for AFE V2.1.1 can accept a large [Time Width(ms)] input without a memory overflow issue.

~ Parameters

X-Axis

Time Top(ms) 0

Time Width(ms) 100

Figure 1-5. Time width setting

1.3.5 Output messages in console when operation failed

QE for AFE V2.1.1 can output messages in console for failed operations:

*  When opening a mismatched device data file

*  When pressing [Stop AFE Monitoring] button failed

*  When invalid data received from board was discarded in drawing waveform

1.3.6 Change [Start AFE Tuning] button text and position

QE for AFE V2.1.1 changes [Start AFE Tuning] icon button to [Start AFE monitoring] botton with text and
move the button position to the left of the toolbar.

O AFE Tuning (QF) % =

® ~ COM Port: > Connect o3

Monitor target SDADC24 | |One-shot l Start AFE monitoring 1l & 5 7B

Figure 1-6. [Start AFE mornitoring] botton

1.3.7 Support to switch the operation buttons style

The operation button display can be switched between two styles: display only icon or display both icon and
text. The favorite style can be selected by the right-click menu.

Voltage |22V £ AVCCO < 2.7V B e

Show Text
m |

Voltage |22V = AVCCO < 2.7V [y Import setting file 3 Export current setting file

[ Write Value to the Target Board [&i Read Value from the Target Board

Figure 1-7. Switching operation button style
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1.4 Supported Environment
+ RA2A1

Windows 10 (64-bit version), Windows 11 (64-bit version)

Renesas e? studio 2023-10 and later

Evaluation board: EK-RA2A1

RA2A1 Group Board Control Program for “QE for AFE” in application note RO1AN5795EJ0200
Note: Board control program should be built with FSP3.6.0.

¢ RX23E-B

Windows 10 (64-bit version), Windows 11 (64-bit version)

Renesas e? studio 2023-10 and later

Evaluation board: RSSK RX23E-B

RX23E-B Group Board Control Program for “QE for AFE” in application note RO1AN6364EJ0100

YVVYV

VVVYY

1.5 Supported Microcontrollers

¢ RA Family (only MCUs that incorporate the AFE)
— RA2A Series: RA2A1

* RX Family (only MCUs that incorporate the AFE)
— RX200 Series: RX23E-B

R20UT5404EC0102 Rev.1.02 Page 6 of 18
Dec.22.23 RENESAS



QE for AFE V2.1.1 Release Note

2. Installation and Uninstallation

2.1 Installing This Product
Use either of the following procedure to install this product.

2.1.1 Install from the "Renesas Software Installer" menu of e? studio

1. Start e? studio.

2. Select the “Renesas Views” - “Renesas Software Installer” menu of e2 studio to open the “Renesas
Software Installer” dialog box.

3. Select the “Renesas QE” and click the “Next >” button

4. Select the “QE for AFE (v2.1.1)" check box and click the “Finish” button.

5. Check that the “Renesas QE for AFE” check box is selected in the “Install” dialog box and click the
“Next >” button.

6. Check that the “Renesas QE for AFE” check box is selected as the target of installation and click the
“Next>" button.

7. After confirming the license agreements, if you agree to the license, select the “I accept the terms of the
license agreements” radio button, and click the “Finish” button.

8. When the dialog box for selecting a trusted certificate appears, check the displayed certificate, and then
click on the “Trust Selected” button to continue installation.

9. Restart the e? studio by following the instructions on the screen.

10. Start this product from the “Renesas Views” - “Renesas QE” menu of e? studio. For details about how to
use this product, see the “Help” menu of e? studio.

2.1.2 Install using QE (zip file) downloaded from the Renesas website
A downloaded zip file has both a plugin version and a standalone version.

2.1.2.1 Install Plugin Version

1. Extract the downloaded zip file.

2. Start the e? studio.

3. Click on “Help”, and then click on the “Install New Software...” menu item to open the “Install” dialog box.

4. Click on the “Add...” button to open the “Add Repository” dialog box.

5. Click on the “Archive...” button, select the installation file (zip file under the QE-AFE folder) in the
opened file selection dialog box, and then click on the “Open” button.

6. Click on the “Add” button in the “Add Repository” dialog box.

7. Expand the “Renesas QE” item shown in the “Install” dialog box, select the “Renesas QE for AFE”
check box, and then click on the “Next>" button.
*If you check off the “Contact all update sites during install to find required software” checkbox, you can
shorten the installation time.

8. Confirm that the installation target is “Renesas QE for AFE”, and then click on the “Next>" button.

9. After checking the license, select the “| accept the terms of the license agreements” radio button if you

agree it, and then click on the “Finish” button.

10. When the dialog box for selecting a trusted certificate appears, check the displayed certificate, and then
click on the “Trust Selected” button to continue the installation.

11. Restart the e? studio by following the instructions on the screen.

12. Start this product from the “Renesas Views” - “Renesas QE” menu of the e? studio. For details about
how to use this product, see the “Help” menu of e? studio.
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2.1.2.2 Install Standalone Version

1. Extract “.zip” file to a user-specified location on the PC.
Note: Please do not put the tool under OS program folder (C:\Program Files)
2. Start this product by double clicking “\QE-AFE\eclipse\ qe-afe.exe”.

3. For the first time this product starts, there is a dialog of license agreement. After checking the license,
you can select “Agree” or “Disagree”.

& End User License Agreement x

USER LICENSE AGREEMENT ~

IMPORTANT-READ CAREFULLY:

This User License Agreement ("ULA") 1s a legal agreement between vou
{etther a natural person or an entity) and Renesas Electronics Corporation
{"Renesas") for the SOFTWARE PRODUCT. As used herein, "SOFTWARE
PRODUCT"

means the Renesas software product provided with this ULA_ which includes
computer software and may include associated media, printed materials,

and "online" files or data. By installing, copving, or otherwise using

the SOFTWARE PRODUCT, vou agree to be bound by the terms of this ULA.
If vou do not agree to the terms of this ULA, do not install or use

the SOFTWARE PRODUCT.

1.SOFTWARE PRODUCT LICENSE

Figure 2-1. License agreement dialog

4. If “Agree” is selected in above step, the product is launched then you can use it; if “Disagree” is selected
in above step, the product won’t be launched.

2.2 Updating This Product
If you have already used this product, you can update it in the same way as the procedure for installation.

2.3 Uninstalling This Product
Follow the procedure below to uninstall this product.

2.3.1 Uninstall Plugin Version

1. Start the e? studio.

2. Select “Help -> About e? studio” to open the “About e2 studio” dialog box.

3. Click the “Installation Details” button to open the “e2 studio Installation Details” dialog box.

4. Select “Renesas QE for AFE” displayed on the “Installed Software” tabbed page and click on the
“Uninstall...” button to open the “Uninstall” dialog box.

Check the displayed information and click on the “Finish” button.

Restart the e2 studio by following the instructions on the screen.

oo

2.3.2 Uninstall Standalone Version
Delete the entire folder which .zip package is extracted.
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3. Notes / Restrictions

3.1 Usage Considerations
Please pay attention to the following items.

Table 3-1 List of Limitation v : Applicable, -: Not Applicable

No Description Remarks

TVvevd
g-3€ZXd

<
AN

1 | Notes on reading Board Control Program application note

2 | Notes on pressing [Write Value to The Target Board] button after v
configuring an AFE component setting

3 | Notes on ADC16 One-shot and Auto mode selection on [Monitor] v

View
4 | Notes on closing [AFE Monitor (QE)] view of e? studio plugin W
version
5 | Notes on OPAMP trimming function failed using Emulator sl-
connection
6 | Notes on downloading AFE adjustment project a4
7 | Notes on location path of standalone version (ge-afe.exe) a4
8 | Notes on using e? studio installation package ars

3.1.1 Notes on reading Board Control Program application note

QE for AFE works with the control program operating on the evaluation board. So when using this product,
please read the related Board Control Program application note first and use the recommended parameters
in the application note. The parameters to be concerned include:

® System clock setting
® Sampling time of communication I/F
® Default bitrate setting of UART connection

3.1.2 Notes on pressing [Write Value to The Target Board] button after configuring an AFE
component setting

It is recommended to press [Write Value to The Target Board] button each time completing one AFE

component configuration and move to next AFE component configuration. The reason is that the board

control program checks the validity of the new register value according to the existing register value on the

evaluation board. Keeping the register values on the evaluation board always consistent with the GUI

configuration can avoid unexpected errors when writing new registers values to the evaluation board.
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3.1.3 Notes on ADC16 One-shot and Auto mode selection on [Monitor] View

ADC16 has 2 monitoring modes: One-shot and Auto. The waveform of these 2 modes is depending on
ADC16 sampling time setting:

B When ADC16 sampling time is short (performing high-speed conversion)
One-shot mode: QE for AFE reads data from evaluation board and draws the waveform only once

Auto mode: QE for AFE reads data from evaluation board and draws the waveform continuously until the
"Stop AFE Monitoring" button is pressed

B When ADC16 sampling time is long (performing low-speed conversion)

Either One-shot mode or Auto mode, the waveform are same: QE for AFE reads data from evaluation
board and draws the waveform continuously until the "Stop AFE Monitoring" button is pressed.

Note: for detailed procedure of One-shot measurement and Auto measurement, please refer to board control
program application note chapter “1.1.2 Measured Value Transmission Operation during A/D Conversion and
Comparison”

3.1.4 Notes on closing [AFE Monitor (QE)] view of e2 studio plugin version

In e2 studio plugin version, if multiple [AFE Monitor (QE)] views are open under different perspectives,
closing one [AFE Monitor (QE)] view while the monitor is running, the monitor won’t be stopped (the tuning
result still can be observed after switching to another perspective). Closing the [AFE Monitor (QE)] view of all
perspectives can end the tuning process.

3.1.5 Notes on OPAMP trimming function failed using Emulator connection

When using Emulator connection mode, OPAMP trimming function occasionally fails. The failed
phenomenon is that even click “Next” and wait a while on Step1 or Step2, the wizard can’t move to next step.
So to execute OPAMP trimming function successfully, please take priority to use USB or UART connection
mode.

B3 User Offset Timming O et

Step 1. Input the voltage to AMPO+ pin

Please connect AMPO+ to 100mY.

Back Mext Finish Cancel

Figure 3-1 OPAMP trimming function dialog
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3.1.6 Notes on downloading AFE adjustment project

To download AFE asjustment project, please kindly take note to set the region using the following steps.
Otherwise, project can’t be downloaded.

1) Select [Window] > [Show View]>[Smart Browser] menu.
2) Select [Setting] in the Smart Browser [View menul].

3) Select one region in the settings dialog and click [Apply and Close] button.

3 F‘f Smart Browser X Q;S“ Q% im

Device: RTFAZATAB(RAZAT) Last updated: 2022/03/25 at 18:19:15 CST
Context Help  User's Manual Technical Update  Application Notes  Tool News Motifications Importdownloaded documents into the internal folder..
Total: 88 | \
Received Date Category Contents {8 Preferences (Filtered) m] X
1 | ') T .
NEW!  2022/03/25 Community M...  Forum Post: § |t)rpefi\tertext * Smart Browser Setting - - 3
NEW!  2022/03/25 Community N... Forum Post:
~ Renesas
NEW!  2022/03/25 Community MN...  Forum Post: § Smart Browser Region setting A
FE - o - - 1 Mainland China/Hong Kong Region ~
Americas

Brazil
Europe/Middle East/Africa
India

Japan
Mainland China/Hong Kong Region

Singapere/South &5Southeast Asia/Oceania
South Korea
Taiwan Region

HTTP connection
Timeout (sec): |1SD

\ v
(?:' g g3 @ Apply and Close Cancel

Figure 3-2 Smart Browser Region setting

3.1.7 Notes on installation path

In the following locations, QE for AFE will not work properly if there is a folder name starting with "u"
(lowercase) in the path.

*  Location of extracting the standalone version (. zip file)

. Location of installing e2 studio

For example, "C:\install\usertool" is an invalid path , because the "usertool" folder starts with "u".
However, for folder names that start with "U" (Uppercase), QE for AFE can work normally.

For example, "C:\User\ < account name >" is a valid path.
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3.1.8 Notes on using e?studio installation package
To install QE AFE V2.1.1 using e?studio installation package, please take note that you must select RA

device family in e2 studio Setup wizard.

M Renesas ¢ studio 2024-01 Setup

Renesas e” studio 2024-01 Setup

Select the device famlies you wish to install support for

RENESAS

=} X 8 Renesas ¢ studio 2024-01 Setup.

Renesas e’ studio 2024-01 Setup

Select the additional software you wish to install

Welcome

(@ Device Families

F.EE“

8k, Debug & Code Generation support for Renesas RA devices

 support for Renesas RZ devices

":"—7'3 Build, Debug & Code Gener
“lax Buikd, Debx

W RHE50
T URHBS0 g supy

n support for Renesss RL7S devices

ua & Code

= e

“IRenesas oY
Suild, Deb

0 @dialog 04

O risc
it for Renesas RISC-V MCU devices

Select All

User: All Users < Back [ Next >

Vieicome v (8] Renesas QE

RIS 7] Q for AFE 214
® Additional

Software

10008

10008
10008
a5 1, £20 Self Check 10008

v Utibies
RX 830202305 830202305 10008

Cancel User: All Usors < Back

o

RENESAS |

149.5 M8 download required

Cancel

Figure 3-3 e?studio Setup wizard setting

In the case that RA device family is not selected, you will meet the following error message on the e? studio

setup end page.

4 eresas ¢ studio 2024-01 Setup

Renesas e’ studio 2024.01 Setup

Vislcoma
Device Familes
Additionl
Software
licorses
Shorteuts
Summany
Instaling.

@ ot

instalstion of
Please el OK o dose.
[Jtaunch e2 studia?

(] View Reloase Notes?
[ e i

o x

RENESAS

e studio s

s New?

202312142031 User: All Users

Figure 3-4 QE AFE installation failed
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There are 2 workarounds are provided when you meet this error.

1) Please try the installation method “2.1.1 Install from the "Renesas Software Installer" menu of e2 studio”.
By this way, QE AFE V2.1.1 can be installed in e?studio without RA device family installed.

Renesas Views Run Window Help

C/C++ >
Code Generator
Debug
Renesas QF
Smart Configurator
Solution Toolkit

I “ Renesas Software Installer I

vov v v v

B Renesas Software Installer

Install Extensions

| QEfor AFE (v2.1.1)

Taoks to assist in development work invalving AFE.

] QE for BLE[RA,RE,RX] (v1.6.0)

Tooks to assist in development wark invehing Buetocth ® Law Energy

QE for Capacitive Touch (v3.3.0)

jocks to assist in the configueation, tuning, and manitoring of touch interfaces. (supparts all tauch

MCUs: RX, RA, RLTS, and Renesas Synergy]

"] QE for Display[RX,RA] (v3.2.0)

assist with timing settings o the image quality of displays. (for us

Tl QE for Motor (v1.2.0)

& with display controllers from

Taoks to assist In the configuration of motor middleware and related drivers.

2 < Back. He

ﬂ,.

@ st

Do you st these sigress? 3, Tne lisplayed ciginatar names ae not necessarey a refiabi cerification of rigin. Far PGP ke
verfication s typiall by querying the key's fingesprint gt a rusted key sere

Type Name
[ xs0m.
[ pep
=

REE-SSID ECIDS; BI030-Da5%4 SOATION BuSnss.

[ Remenber sesectea signers (] Anwans tust 4 content

Desetect A1l

REE-550 Eclipse; rand- based Sciusion Busness Ui, Renasas Electionics Eurape Lia

& ouan || & Expan.

Classites W

Version
osgibundle com renesasqe.afe component 1.20,026231102.6289

‘osgibundle com renesas qe.afe. 10.1.420231102-8901

‘osgibundle ‘com renesas qe.afe help 1002023071710

‘osgibundle ‘com renesas.qe.afe.model 120020230925 0332

orgedlpse.update feat... com renesas.qe geale.feature 2.1.1.420231102-0901

osgl bundle com.sun jna 5.13.0420230812-1000
osgibundle g freemarker freemarker 2.32stable

) I Tnst Sebected. I Cancel

Figure 3-5 To install QE AFE without RA device family installed

2) Please re-install €2 studio. On the device selection wizard page, please take note to select RA device
family (refer to Figure 3-3).
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QE for AFE V2.1.1

Release Note

3.2 Functional Restrictions
The following restrictions apply to QE for AFE V2.1.1. These restrictions will be solved in next or future

version.

Table 3-2 List of Restrictions

v . Applicable, -: Not Applicable

I
>| X
Lo NN
No Description > W Remarks
=l m
vy)
1 | Restrictions on showing a video about how to use QE AFE - |V
2 | Restrictions on ACMPLP configuration v/
3 | Restrictions on migration pin allocation to Smart Configurator - |V

3.2.1 Restrictions on showing a video about how to use QE AFE
The video is not ready for publish, so you can't open the video even if you press the video button.

[Workaround]

Please wait for the video content published.

®

Figure 3-3 Video button
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QE for AFE V2.1.1 Release Note

3.2.2 Restrictions on ACMPLP configuration
B “DACS8 channel 0 output” is selected as ACMPLPO input (refer to figure3-4 (1))

»  When switcher (A) selects Vref (refer to figure3-4 (A))
» When ACMPLPO is disabled (refer to figure3-4 (D))

»  When switcher (B) selects IVREFO, switcher (C) selects Vref (refer to figure3-4 (B) and (C)) and
ACMPLP1 is enabled (figure3-4 (E) selects “Enable”)

CMPINO —— IVCMPO

AMPOO —»
P
™ | acMpLPo | Disable (D3
CMPREFO —® IVREFO \ g
DACS8 channel 0 output (1 —m = | v > Window Function
) Noise Filter
(A

Vref T

l —
ACMPLP1 | Disable (E)
B) | o)
™ »> g - Window Function
CMPREF1 —»| :) »
DAC8 channel 1 output (2)—® « |[[IVREF1 ) C - Moise Filter
CMPIN1 ——»| IVCMP1
AMP10 ——»|
—
|

Figure 3-4 ACMPLP1 example setting

Either of above ACMPLPO settings will cause the register value cannot be successfully written to the EK-
RA2A1 board with the following 1) — 3) settings.

1) Set P013 as DA8_0 function in DACS8 page (PO13PFS = 0A018000)
Figure 3-5 DAS8_0 example setting

Channel 0 | Enable -

= _ ||_Output to pin

»DAS_0
Conversion Value{Hex) 00

R20UT5404EC0102 Rev.1.02 Page 15 of 18
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QE for AFE V2.1.1 Release Note

2) Select DA8_0 as OPAMP1 input in OPAMP page (AMP1PS = 80)

]
OPAMP1 | Enable h
DAS_0 b o
';M o | b Charge Pump | Enable -
P Disable ~
AMP1+ P Disable -
&————Pp Disable - NN
AMP1
AMP1- b e » -
> L1

Figure 3-6 OPAMP example setting

3) Select "DACS8 channel 0 output” as input in ACMPHS page (CMPSEL1 = 08)
Figure 3-7 ACMPHS example setting
H"“\-\
ANOTT ——
ANDDE —
ANDTT —
DACS channel 0 output  ——{ (=) |
DACT 2 output —w

Wref ———i
L
ACMWPHS
AMNOOD — » Enzble - Mot inverted > —
AMNDDE —
ANDE —
+

[Workaround]

In above ACMPLPO setting, (1) setting is invalid. So please change (1) from “DAC8 channel 0 output” to
“CMPREFO0”.

B “DACS8 channel 1 output” is selected as ACMPLPL1 input (refer to figure3-4 (2))
»  When switcher (B) selects IVREFO (refer to figure3-4 (B))
»  When switcher (C) selects Vref (refer to figure3-4 (C))
» When ACMPLP1 is disabled (refer to figure3-4 (E))

Either of above ACMPLP1 settings will cause the same limitations 1) and 2) as selecting” DAC8 channel 0
output “above.

[Workaround]

In above ACMPLP1 setting, (2) setting is invalid. So please change (2) from “DACS8 channel 1 output” to
“CMPREF1".

R20UT5404EC0102 Rev.1.02 Page 16 of 18
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3.2.3 Restrictions on migration pin allocation to Smart Configurator

When reflecting AFE setting to Smart Configurator, in certain case, the pin allocation in QE for AFE might be
lost in Smart Configurator [Pin] > [Pin Funcions] setting.

AFE connection (QE)

| Mo

2

Adjustment Results

To reflect AFE adjustment result in the project, click the button below
to generate a SC project file firstly, and open scfg in Smart
Configurator, then click [Generate code] in Smart Configurator

Generate AFE Setting

O

Smart Configurator

[Workaround]

Ferwerce voinge o =
st Pin configuration 2
" S 9 Generate Code  Generate Report
woum k asv
i Hardware Reso... = 1% &% PinFunction 2 H R s
L3 I | [orpe filtertext (" = any string, ? = any character] | [an =
W SCis @ Enabled  Function Assignment Pin Number Direction  Remarks -
"‘KS;”Z . il DIRGOE 2 Notassianed 2 Motassigned  Non
o R”“;D‘m e O ®ano # Notassigned # Notassigned None Component requires a pin
.s ioheral et O A # Not assigned 7 Notassigned None
vl E':S;’E"" eral interfacy O @®anz v # Notassigned Mone Compenent requires a pin
"CAN l O ®ans v # Notassigned  None Component requires a pin
vl [A"I\‘fn ule O ang # Not assigned # Notassigned MNone
o .wz CAD comvert O AN 7 Notassigned 7 Notassigned Mone
~ il -sw‘z’:’DDMVE e O ANs # Not assigned 7 Notassigned None
" vy . O AN7 . 7 Notassigned None
Lt L3V ‘””"; < O ’ # Notassigned Nane Component requires a pin
Fe = O 7 # Notassigned MNone Component requires a pin
2 Analog power sUpply = =
s y e Ty
i LD ContrlleDriver O ann y y Nome
36 1/O Ports e — Al 2 2 Monn e
< > < >
Overview | Board | Clocks | System Cumnunemnlenupts

Figure 3-8 Mising pin allocation

After “Generate AFE Setting” operation, please open Smart Configurator [Pin] > [Pin Funcions] and check. If
the AFE module on the left tree display an error, then manually select the pins on the right table according to

QE for AFE setting.

. . i =
Pin configuration Ganera&lcm Generate Report
Hardware Reso... © /% & PinFunction U - [} =1
[Fope fitter text ] [eypefitter text * = any string, ? = any character] | [ <
= SCI9 o Enabled  Function Assignment Pin Number Direction  Remarks )
@ 5chz ADTRGO® # Not assigned # Notassigned  None
~ 8t 12C bus interface AINO # AINO/ANDGD 776 |
@ RICD AINT # Not assigned # Notassigned  None
~ 8t Serial peripheral interfac: AN2 # VREFLO/AINZ 778 10
..a[g.uzs::dme AIN3 # VREFHO/AINZ s 7 10
AN # Not assigned # Notassigned None
v cano AINS # Not assigned # Notassigned  None
-bit A/D converter ANG # Not sssigned 7 Notassigned None
S124D0 AINT # Not assigned # Notassigned  None
AINE 7 AINg 786 10
Tnalog power supply s £ o i "
%, LD Controlle/Driver AN £ Mok ssigned T
o AINTI # Nt assigned # Notassigned None
30 1/0 Ports © ania 5 Rt e a 2 Bt arcine A Mane v
< > >

in Number

Overview | Board | Clecks | System | Component{ | Pins Jinterrupts

Figure 3-9 Select the pins manually

R20UT5404EC0102 Rev.1.02
Dec.22.23

RENESAS

Page 17 of 18




QE for AFE V2.1.1

Release Note

Revision History

Description
Rev. Date Page Summary
1.00 Nov.15.23 - First edition issued.
1.01 Dec.12.23 11 Added “3.1.7 Notes on installation path”
1.02 Dec.22.23 12,13 Added “3.1.8 Notes on using e2studio installation package”
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between V. (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-
evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

(Notel)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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